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Summary 

Objectives 

The objective of this document is to describe the aim of EDGE, how to use it and the 

main concepts behind it. 

Diffusion 

Nom Organization 

Users of Edge - 

 

Changes record 

Version Revision Date Author / Modification 

1 0 03/09/2015 Arnaud Trouche / Document creation 

1 1 06/06/2016 Arnaud Trouche / Update with latest developments 

1 2 10/06/2016 Elsa Kress / Update  

2 0 05/08/2016 Arnaud Trouche / Add the material edition, rearrangement 

2 1 05/08/2016 Elsa Kress / Update 

2 2 02/11/2016 Arnaud Trouche / Update 

3 0 05/10/2017 Amandine Champlain / Update to the new version of the software 

3 1 09/04/2018 Arnaud Trouche / Updates for EDGE 2.1.1 



 
EDGE (ExtendeD Gdml Editor) 2.2.0 

User Manual 
PAGE 

4/42 

 

Status: final Date: 09/04/2018  

 

1. Introduction 

1.1. Scope of the document 

This document describes the EDGE CAD editor, the context and the concepts behind 

its conception, as well as its use.   

1.2. Reference documents 

[RD1] GDML Web page, http://gdml.web.cern.ch/GDML/ 

[RD2] GEANT-4 Web page, https://geant4.web.cern.ch/geant4/ 

[RD3] SpaceSuite Web site, www.space-suite.com 

[RD4] Santin G. et al., “GRAS: A General-Purpose 3-D Modular Simulation Tool for Space 

Environment Effects Analysis”, IEEE Trans. Nucl. Sci., Vol. 52, No. 6, December 2005 

[RD5] Jeanty-Ruard B. et al, “Advanced CAD Tool and experimental integration of GRAS/GEANT-4 for 

internal charging analysis in SPIS”, Proceedings, 14th Spacecraft Charging Technology Conference, 

ESA/ESTEC, Noordwijk, NL, 04-08 APRIL 2016 

[RD6] Keridwen open-source IME Web site, www.keridwen.org 

[RD7] SPINE community Web site, www.spis.org 

[RD8] EDGE project Web page, http://dev.artenum.com/projects/edge_extended_gdml_editor 

1.3.  Acronyms and abbreviations 

 B-Rep: Boundary Representation 

 CAD: Computer Assisted Design 

 CSG: Constructive Solid Geometry 

 EDGE: ExtendeD Gdml Editor 

 GDML: Geometry Description Mark-up Language 

 GUI: Graphical User Interface 

 IME: Integrated Modelling Environment 

 STL: STereo-Lithography 

 UNV: Universal File Format 

 XML: Extensive Markup Language 

http://gdml.web.cern.ch/GDML/
https://geant4.web.cern.ch/geant4/
http://www.spis-services.eu/
http://www.keridwen.org/
http://www.spis.org/
http://dev.artenum.com/projects/edge_extended_gdml_editor
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2. EDGE objectives 

EDGE — for ExtendeD Gdml Editor — is an easy-to-use GDML-based CAD editor. 

It provides a powerful and flexible CSG model fully compliant with the GDML CAD 

format [RD1], used by numerous particle-matter interactions analysis tools based on 

the GEANT-4 library [RD2]. EDGE provides also various import/export capabilities 

from/to B-Rep based CAD formats.  

EDGE has been developed by Artenum in the frame of its internal R&D activities and 

is available through several of its commercial services offers, like SpaceSuite [RD3].  

2.1. About GDML 

Based on XML syntax, the Geometry Description Markup Language (GDML) is the 

reference language used to describe geometrical models (i.e. CAD models) for 

radiation modelling tools like GEANT-4 [RD2], ESA/GRAS [RD4] or SPIS-IC [RD5]. 

GDML is based on a rich CSG approach and can be used to create complex and 

realistic geometrical systems to be used for various purposes. 

As an XML-based language, it can be fairly well read by humans and it is quite 

simple to parse it. However, one of its limits is that it is difficult to visualise what a 

GDML file is going to produce just by looking at it in a tailored sense, i.e. as a 3D 

geometrical system. Although some viewers or editors exist, only a few of them are 

publicly available, and they are not user-friendly or incomplete. Moreover, most 

GDML editors so far can not handle the depth hierarchy used in GDML. 

Therefore, Artenum decided to develop a GDML editor based on the IME Keridwen 

[RD6]. Its aim is to propose a simple-to-use, cross-platform editor with good 

capacities of visualization.  

2.2. Main functionalities 

EDGE can either create or load a complete GDML model. In both cases, the user 

can modify the properties of all the shapes or add new shapes. Moreover, shapes 

also have position and orientation properties that allow placing them correctly. 

To facilitate the work for the user, position and orientation can be applied to several 

objects at the same time. EDGE handles complex hierarchies with several levels of 

depth.  

EDGE also allows editing and attributing material properties to each shape 

individually. 

At any time, the user can see the results of his work thanks to the real-time 3D. 

https://geant4.web.cern.ch/geant4/
http://space-env.esa.int/index.php/geant4-radiation-analysis-for-space.html
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After editing his file, the user can save the result back to GDML but he can also 

export it to the B-Rep .geo format (the file format of Gmsh)
1
.  

2.3. Supported formats 

2.3.1. Import 

EDGE support natively the GDML format in reading and writing, but is also able to 

import numerous B-Rep CAD formats like Gmsh’s geo or STEP-AP 203/214 and 

tessellated solids in STL or UNV files. These import/export capabilities open 

interoperability bridges with other CAD tools and multi-physics simulation software. 

  

Figure 1: Example of imported STEP-AP model inside EDGE 

2.3.2. Export and CSG-to-B-Rep decomposition 

EDGE is able to convert GDML models into an equivalent Gmsh’s geo file, fully 

compliant with tailored applications like SPIS [RD7]. This conversion is not done by 

tessellation but by a proper CSG to B-Rep decomposition with the view in Gmsh 

(on the top of Figure 2) of a model initially defined in EDGE (on the bottom of Figure 

2). 

  

 

                                            
1
 http://geuz.org/gmsh/ 

http://geuz.org/gmsh/
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Figure 2: CSG to B-Rep decomposition of a GDML model defined in EDGE (top) 

visualized in Gmsh (bottom) 
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3. Using EDGE 

3.1. Supported platforms  

Currently, EDGE can be used on most 64bits Linux platforms, Microsoft Windows-7-

8-10 32/64bits and OSX/macOS 64bits.  

3.2. Starting Edge 

The application as well as the present User Manual can be downloaded from the 

Artenum/EDGE Web page [RD8].   

Once downloaded, the zip file containing the EDGE snapshot has to be extracted on 

the machine where it will be used on to ensure that the software is executable.  

To start the application, open a terminal and just execute the Edge.sh/Edge.bat file, 

respectively for Linux-OSX/Windows systems.   

On recent Linux distributions with Gnome, a double-click on the Edge.sh displays the 

content of the file instead of launching it. You can modify this behaviour by going to 

the file manager preferences and changing the way executable files are handled. 

3.3. EDGE Main Window 

The GUI of EDGE is very intuitive and based on the concept of “perspectives”, where 

the modelled system can be viewed and handled from different approach or points of 

view, like the edition of the geometrical model, the definition of material properties or 

the affectation of these materials. 

Even if EDGE has three main different perspectives (geometrical edition, material 

edition and material affectation), some elements are common in all views as shows 

the Figure 3:  

 (1) Main Menu corresponds to main control menu of the application. It is 

always available.  

 (2) General Toolbar presents shortcut buttons to open and save a file and 

also allows switching from a perspective to another (e.g. preferences, 

geometry, material definition and material affectation). It is always available. 

These elements are described in further details in the following sections.  

http://dev.artenum.com/projects/edge_extended_gdml_editor
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Figure 3: Main elements of EDGE window (here in the geometry perspective) 

3.3.1. Main Menu 

The File menu shown on Figure 4 (top) allows opening from GDML, saving in GDML 

and exporting to .geo format. When opening a GDML file, if this file contains for 

example two solids with the same name, EDGE will only consider the last element 

with this name. A warning will be displayed, informing the user that several shapes 

have the same name.  

Remark: Please note that only one GDML file can be opened at a time in EDGE. 

Opening another GDML file will delete all unsaved previous work. 

The Tools menu shown on Figure 4 (bottom) allows opening a console log, mainly for 

advanced users, and checking the validity of any GDML file, not only the one opened 

in EDGE, against the different versions of GDML format specifications. This tool only 

notes the first error in the file, even if there are several of them, and warns the user 

about it. This menu also offers access to the various model computations, described 

in more details in section 5.5. 

The Views menu allows switching from one of the perspectives presented earlier to 

another, expect for the Preferences. 

The Help menu is useful to access the EDGE User Manual and to obtain information 

about the software.  

 1 

  

 2 
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Figure 4: EDGE file menu (top) and tools menu (bottom) 

3.3.2. General Toolbar 

The left part of this toolbar allows the user, thanks to three buttons, to access the 

Preferences, presented in section 4, and to easily open and save a file without 

opening the File menu presented in 3.3.1 (cf. Figure 4). 

The right part of this toolbar presents three buttons allowing the user to switch 

between the three main perspectives of EDGE: the Geometry edition (visible in the 

Figure 9, see section 5), the Material definition (see section 6) and the Material 

affectation one (see section 7 for more information). 
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4. Preferences 

The Preferences dialog box is automatically displayed during the first launch of 

EDGE. The user can access it afterwards thanks to the Perspective selection toolbar. 

By clicking on the button , the user can access to a panel allowing the setting of 

general options, as shown on Figure 5. On each tab, the “Reset to default” buttons 

allow switching back to the initial preferences. 

NB: Every modal window, such as the preferences dialog, the addition of a new 

shape or the application of a transformation, can be closed by typing on the “ESC” 

key.  

 

Figure 5: Preferences dialog box 

The first tab, see Figure 5, offers options concerning the GDML materials. The user 

can choose the default shape material, which is the material attributed by default to 

all shapes created in the geometry. The user can also select which default material 

he wants to attribute to the world shape. 

The second tab, shown on Figure 6, sets parameters for the GDML writer: 

 The writing of default values or not: if this option is selected, the default 

values chosen in EDGE (mainly zeros) will be written inside the GDML 

file; 

 The writing of default units: if this option is selected, the units will be 

specified inside the GDML file; 

 The writing of non-used user-defined materials: if this option is selected 

and that the user has defined materials which are not attributed to a 

geometric shape, those materials will be stored in the GDML file 

anyway. 
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Figure 6: GDML writer options 

The third tab offers more general usability preferences, as shown on Figure 7: 

 The user can choose the default opacity used when adding a new shape to 

the 3D view. Indeed, a colour is automatically chosen for every new shape 

and this setting will choose the opacity for this colour. Please note that this 

setting will not change the opacity of the shapes already displayed in the 3D 

view; 

 The option “enable drag’n’drop” allows to enable the possibility to move the 

elements in the Shapes tree using drag’n’drop. It facilitates the modification of 

the hierarchy. This option is disabled by default;  

 It is also possible to display “Add new shape” shortcut labels in the shapes 

tree of the Geometry Edition perspective. These labels help to gain time to 

add new shape but this option is disabled by default to gain cleanliness, see 

section 0. 

 

Figure 7: General options 
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The last tab sets preferences for the system, as shown on Figure 8. The user can 

choose: 

 The application cache directory: by clicking on the “Browse” button, 

the user can choose the path where the application stores its temporary 

files. It may be useful to change this setting if you do not have write 

access to your temporary folder (by default EDGE uses the operating 

system default temporary folder); 

 The maximum allocated memory: the user can choose the value and 

unit (Mo or Go) of the available memory for EDGE. It can be useful to 

increase this value when loading very big files, without exceeding the 

system maximum capabilities. 

 

Figure 8: System options 
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5. Geometry Edition 

The Geometry perspective is the main perspective of EDGE since it allows the 

creation and the edition of geometrical elements. 

5.1. The Geometry edition perspective 

It is the main perspective of EDGE displayed by default at the launching. It has two 

main panels to edit the geometry, as shows Figure 9: 

 (1) Shapes Tree panel, to visualise and edit the list of geometric shapes; 

 (2) Properties panel, to edit the properties of the currently selected shape; 

 (3) 3D Viewer panel, present only for the geometrical edition and material 

affectation perspectives, provides a 3D view of the modelled system.  

These panels, as well as the 3D View panel, can be moved, detached or maximized 

at the user’s liking using the buttons on their top right corner. 

 

Figure 9: EDGE geometry edition view 

  

 

 1 

 2 

 3 
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5.1.1. Shapes tree 

The Shapes tree lists all the shapes currently defined in the geometrical model and 

displayed in the 3D scene. It also shows the hierarchy of the shapes. The shape(s) 

currently selected is highlighted in the 3D view on the right with a red box. It is also 

possible to move one geometry element and all its children elements to another 

logical location in the geometry tree. This feature is available only if the drag’n’drop 

option has been enabled in the Preferences, see section 4. 

On the right of each shape, a click on the coloured box opens a dialog that allows 

changing the colour of the shape in the 3D view. It is also possible to change the 

transparency of the selected element in this dialog box, as shown on Figure 10. A 

checkbox at right controls the visibility of the object in the 3D view.  

 

Figure 10: Colour changing dialog box 

On top of the tree, five buttons are used to control the shapes: 

 The three buttons on the left side allow adding, duplicating and/or removing 

shapes. The first one ( ) opens a dialog box to add a new shape to the tree 

(more details in section 5.4.1). The second one ( ) duplicates the selected 

shape(s) and the third one ( ) deletes all the shapes currently selected in 

the tree.  

 

 The two buttons on the right side allow performing actions on the currently 

selected shape(s). The first one ( ) opens a dialog box to apply a 

transformation to all the elements currently selected (more details in section 

5.4). The second one ( ) offers the possibility to use a clipping filter. 

This button triggers the apparition of a dialog box allowing the user to set the 
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parameters of the clipping filter, see Figure 11. This filter performs a cut in the 

geometry to view more precisely the inner geometry of the modelled system. 

The clipping is set with the coordinates of a centre point and a normal 

direction. It will keep the geometric representation of the selected element in 

the half-space defined by this point and the normal. To get a more interactive 

setting, you can selected the “Display 3D control widget” that will display an 

interactive control in the 3D view to change the clipping. This 3D control of the 

filter are materialised by a sphere (representing the centre of the clipping 

operation) and an axis with two arrows (representing the normal direction), 

see Figure 12. 

 

Figure 11: Clipping dialog box 

 

Figure 12: Clipping filter applied on a Raspberry Pi Zero housing with the 3D 

control widget enabled 



 
EDGE (ExtendeD Gdml Editor) 2.2.0 

User Manual 
PAGE 

17/42 

 

Status: final Date: 09/04/2018  

 

5.1.2. Properties panel 

This panel shows the properties of the shape currently selected in the Shapes tree. 

It shows properties only if there is one — and only one — shape selected. Depending 

on the shape selected, the properties displayed change accordingly.  

The user can thus define the dimensions of the shape and also — for box, cylinder 

and cone shapes —an additional useful parameter (not present in GDML) the 

thickness. If a shape has a thickness defined (different from 0), then the export of this 

shape will be done using Boolean operations (a subtraction between the outer 

element and the inner element). This kind of shape can be very useful during the 

definition of radiation analysis. The user shall be aware that this thickness value is 

not a GDML parameter, which means that setting this parameter to a value different 

from zero will result, in the GDML file, to the corresponding Boolean operation. 

This panel shows also fields to choose the position and orientation of the object and 

the unit of measure. The position (0, 0, 0) corresponds to the barycentre of the World 

shape (see section 5.4.1). 

The unit can be changed and it is proposed to convert all the relevant data to the new 

unit format. The default units are millimetres (mm) and radians (rad).  

5.1.3. 3D View 

The 3D view is showing in real-time the product of the GDML model. It is possible to 

interact with the view using the mouse to control it: 

 Left click (hold) and movement: rotate the scene; 

 Wheel (hold) and movement: translate the scene; 

 Right click (hold) and movement: zoom; 

Or the keyboard: 

 “R” resets the view and shows all the shapes of the scene; 

 “I” to zoom in; 

 “O” to zoom out;   

 “W” displays the shapes as wireframes; 

 “S” displays the shapes as solid; 

 The up/down/left/right arrows rotate the scene.  
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The buttons at the top of the view also facilitate its handling: 

  resets the view and shows all the shapes of the scene (equivalent 

to the “R” key shortcut); 

  aligns the view along +X axis; 

  aligns the view along -X axis; 

  aligns the view along +Y axis; 

  aligns the view along –Y axis; 

  aligns the view along +Z axis; 

  aligns the view along -Z axis. 

NB: sometimes, at the launch of the software, the 3D view is not correctly initialised. 

To refresh it, change perspective to another one and come back to the initial 

perspective, the 3D view is now correctly initialised. It can also happen when using 

several screen and moving the application from one screen to another one. 

On top of the 3D view, a drop-down menu (cf. Figure 13) allos the user to choose a 

model operation to launch (cf. section 5.5). These operations are also available 

through the Tools menu presented on Figure 4. 

 

Figure 13: Drop-down menu “Model operations” of the 3D view 

5.2. Available geometric shapes 

EDGE is currently handling the following shapes: cone, ellipsoid, elliptical cone, 

elliptical tube, box, orb, paraboloid, sphere, and tube (see Figure 14). Other kind of 

shapes are also supported and presented in section 5.3. 

 

Figure 14: Available shapes 

5.2.1. Cone 

A segmented or complete cone with a thickness and the possibility to have only a 

portion of its circumference. 

rmin1 inner radius at base of cone rmax1 outer radius at base of cone 
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rmin2 inner radius at top of cone 

rmax2 outer radius at top of cone 

z height of cone segment 

startphi start angle of the segment 

relative to the x axis  

deltaphi angle of the segment

 

Figure 15: Geometrical properties of the cone  

(A: whole view; B: basal section) 

5.2.2. Ellipsoid 

An ellipsoid, where half-axis dimensions can be different along the three axes and 

which can be cut at the top and/or the bottom. 

ax x semi axis 

by y semi axis 

cz z semi axis 

zcut1 height from the centre to the 

truncated base  

zcut2 height from the centre to the 

truncated top 

 

Figure 16: Geometrical properties of the ellipsoid 

5.2.3. Elliptical Cone 

A segmented or complete cone that can have a different radius along the x and y 

radius.  
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dx x semi axis 

dy y semi axis 

zmax total z length without cut 

zcut upper cut in Z 

 

Figure 17: Geometrical properties of the elliptical cone 
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5.2.4. Elliptical Tube 

A complete tube that can have a different radius along the x and y radius. 

dx x semi axis 

dy y semi axis 

dz z semi axis 

 

Figure 18: Geometrical properties of the elliptical tube 

 

5.2.5. Box 

A simple box with the possibility to edit the x, y, z dimensions. This allows only to 

draw rectangular solids. 

  

Figure 19: Geometrical properties of the box 
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5.2.6. Orb 

A simple complete sphere with only one parameter, r, as the radius.

 

Figure 20: Geometrical properties of the orb 

5.2.7. Paraboloid 

A portion of a paraboloid, which can be cut at the top.

rlo radius at -z 

rhi radius at +z 

dz z length 

 

Figure 21:  Geometrical properties of the paraboloid 
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5.2.8. Sphere 

A fully customizable sphere, with a thickness.

rmin inner radius  

rmax outer radius 

startphi starting angle of the 

“horizontal” segment  

deltaphi delta angle of the “horizontal” 

segment 

starttheta starting angle of the 

“vertical” segment  

deltatheta delta angle of the “vertical” 

segment 

 

Figure 22: Geometrical properties of the sphere  

(A: whole view; B: horizontal section; C: Vertical section) 

5.2.9. Tube 

A segment or complete tube, with a circular basis only, a thickness and the possibility 

to have only a portion of its circumference. 

rmin inside radius of segment  

rmax outside radius of segment 

z z length of tube segment 

startphi starting phi position angle of 

segment  

deltaphi delta angle of segment 
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Figure 23: Geometrical properties of the tube (A: whole view; B: section) 

5.3. Other shapes available  

5.3.1. Tessellated Solid 

Solids with complex geometries can be constructed by importing tessellated 

surfaces, including initially B-Rep based models. Numerous formats are supported 

(.geo, mesh file, STEP AP 203 – 214 ...). Those tessellated surfaces are converted 

into an equivalent GDML tessellated solid object. 

Please notice that the imported tessellated surface must imperatively be a close 

surface. EDGE displays a warning message to the user if it is not the case.  

 

Figure 24: Example of an imported tessellated solid 
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5.3.2. Assemblies 

In EDGE, the user has the possibility to handle “assembly” elements. 

Those elements are grouping several shapes without being attached to a geometric 

shape. 

5.3.3. GDML file 

EDGE also allows importing all the geometry concepts from another GDML file and 

including them as a child of the currently selected element. This option can be very 

useful if users want to check the position of a specific subsystem (defined in the 

imported GDML file) in the whole system (main GDML file). 

5.4. Edition of the geometry 

5.4.1. Creating/adding a new shape 

The user has first to create a “world” shape that will include all subsequent shapes. 

Even if technically GDML allows creating a world smaller than the final object, it is not 

recommended. The world shape typically corresponds to the computational domain 

of numerous of simulation software using GDML files in input. And most of these 

tools will not work properly nor give relevant results if the world shape does not 

encapsulate all other elements. The relevant definition of the world shape remains on 

the responsibility of the user and with respect to the final targeted application.  

The position (0, 0, 0) corresponds to the barycentre of this world shape. 

Once this is done, it is possible to start the construction of the desired object. 

Clicking on the “ ” button (or the Add the world shape /“ ” link if the 

corresponding option in the Preferences is enabled, see section 0), calls the New 

Shape Wizard (Figure 25). On the left panel of the dialog box, all the available 

shapes are represented. A click on a shape selects it and shows its properties on the 

right panel. Properties requirement varies with the different shapes, but for each ones 

the Name, Unit Configuration, Position and Rotation can be informed. All the 

properties can be edited via the Properties Panel (Figure 9, box 3).  
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Figure 25: New shape dialog box 

If the tree is empty, the first new shape will become the “world” shape. After that, 

each new shape will be added to the tree as a child of the current selected element. 

If no element is selected, the new element will be added as a child of the “world box”. 

This feature makes possible the creation of objects with a complex hierarchy of 

objects.  

The new shape dialog box allows the import of B-Rep format files, as tessellated 

shapes, or GDML files as children of an existing shape, see section 5.3. 

5.4.2.  Transforming several elements 

Position and orientation can be directly edited in the properties panel. However, as it 

is not convenient to use this feature on each element to move, a multi-transformation 

tool has been implemented, accessible via the “Transform” icon of the Shapes tree 

panel (see section 0). 

Once the elements to modify in the tree are selected, click on the Transform button   

( ). The dialog box showed in Figure 26 then appears. 
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Figure 26: Multi-element transformation dialog 

This dialog allows setting the translation and rotation to apply to the elements. 

These transformations can replace the current position and orientation properties of 

the objects or be added to any existing placement information. For example, for an 

object at a (1, 1, 1) position, a transformation of (2, 0, 0) with “Add” will displace the 

object to (3, 1, 1), when “Replace” will displace it to (2, 0, 0). 

5.5. Model operations 

The user can obtain information about the created shapes thanks to the drop-down 

menu “Model operations”, as shown on Figure 13. The list of available operations 

may be subject to changes.  

Available operations are: 

 “Check for overlaps”: allows the user to check if there are no overlaps 

inside the geometry, meaning that there are no shapes overlapping 

each other. The user can choose if “touching” shapes should be 

considered as overlapping or not. To launch the calculation, the user 

can click on the “Play” button. The “Stop” button allows the user to stop 

the calculation at any time. The results of the operation are presented 

on Figure 28; 
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Figure 27: Overlaps checking dialog box 

 

Figure 28: Overlaps calculation results (indicates that the Box2 and Box 

elements are overlapping) 
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 “Compute volume”: allows the user to obtain the volume of the 

geometry. The computed value is an approximation of the real volume 

value based on 3D meshing of the shapes. As for the previous 

operation, the calculation is launch with the “Play” button and can be 

stopped with the “Stop” button (cf. Figure 29). 

 

Figure 29: Volume computation results 
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 “Reorganise model”: allows the user to check the consistency of the 

hierarchy of the model. Indeed, to get proper radiations results, 

elements that are included in other ones (geometrically) should be 

placed as child of the geometrical shapes they are in. This tool 

computes the real hierarchy, displays the results to the user and 

proposes to modify the model accordingly. NB: due to current limitation 

on this tool, it will remove all assemblies from the model. 

 

 

Figure 30: Exemple of hierarchy reorganisation results. 
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6. Material definition 

The aim of this perspective is to define materials that will be attributed later to a 

geometric shape. 

The Material definition perspective has no 3D view but is composed of four main 

panels, as shown on Figure 31: 

1- Materials list 

2- Available GEANT-4 materials 

3- Material tree 

4- Material editor 

 

Figure 31: EDGE material definition view 

6.1. Materials list 

This panel displays a list of all the materials, created by the user or not, as shown on 

Figure 33. EDGE contains one default material, named Default Material. This 

material is not editable (but may be duplicated).  

In order to edit a material, the user can create a new one by clicking on ( ). 

The dialog box shown on Figure 34 then appears and asks the user to fill in the 

material name and density in g/cm3, before choosing the type of material (see 

below). 

1 

2 

3 4 
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General optional properties can be set by clicking on the “Show optional properties” 

and are: 

 The choice of the atomic number Z; 

 The formula; 

 The state (liquid, solid, gaseous); 

 The absorption length (AL); 

 The mean excitation energy (MEE); 

 The pressure (P); 

 The radiation length (RL); 

 The temperature (T). 

 

Figure 32: Material creation dialog box 

The user can then choose a material type. As shows Figure 33, a material can be 

defined by three different ways.  

The first way simply consists in defining the material as one atom. For example, 

helium is defined as a single atom of helium. 

The other possible definitions consist in defining an association of different elements. 

The difference is that a composition uses integer to indicate the repartition (2 atoms 

of X, 1 atom of Y …) whereas the fraction uses percentages to indicate the repartition 

(0.4 of the total is made of X and 0.6 of the total is made of Y). Then, each fraction or 

composition can contain an atom or a fraction of composites. 

Figure 34 presents different examples of material defined using the GDML formalism. 
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Figure 33: Material definition in GDML 

 

Figure 34: Examples of different ways of defining a material in GDML 

Finally, the user can choose the atom value in g/mol of the newly created material. 

The material is created when the user clicks on “Add material”. This new material 

appears at the end of the Material list. 

Warning: If the user creates a new material which is not attributed to a 

geometrical shape in the Materials affectation perspective, this material will 

not be saved inside the .gdml file when the user saves the file to GDML in 

EDGE. In order to save materials which are not attributed inside the .gdml file, 

the user needs to activate the corresponding option, see section 0. 

The user can also duplicate a material by clicking on ( ). Those new materials are 

added at the end of the materials list and their names are incremented in order to not 

confuse them with the initial materials. 

The user has also the possibility to delete a selected material by clicking on ( ). 
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By clicking on ( ), the user will be able to import materials from another GDML file 

or from a GDML materials XML file. In the case of a GDML file, this mechanism will 

import all materials written inside the GDML file. We remind that in order to write in a 

GDML file all materials, even the ones which are not affected to a geometry shape, 

the user must enable the corresponding option in the Preferences (see section 0). 

Finally, by clicking on the export button ( ), it is possible to export the materials 

into a GDML material file (.xml). All the user-defined materials will be exported. 

6.2. Available GEANT-4 materials 

Several pre-existing GEANT-4 materials are listed in EDGE and are available for the 

material affectation, see section 7. The complete list is displayed in the GEANT-4 

materials panel, as shown on Figure 31. Those materials are displayed here to 

inform the user that they will be available during the material affectation, 

see section 7. 

6.3. Material tree 

This panel displays the current material selected in the Materials list, this one being 

either newly created by the user or pre-existing in EDGE. It shows the entire tree 

view of the material, as shown on Figure 35. 

 

Figure 35: Tree view of a material 

Once a material is created or selected in the materials list and displayed in the 

material tree, it is possible to edit it by selecting the properties ( or ) and 
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characteristics ( ) in the material tree on the left. Once selected, the correct editor is 

displayed in the material editor where the different values can be modified. 

 

The properties can be duplicated by selecting them, right-clicking and selecting 

Duplicate this property as shown on Figure 36. The duplicate function will duplicate 

the property as well as its characteristics and its sub-properties recursively. This 

menu also allows deleting a property. The same actions can be applied to 

characteristics. 

 

Figure 36: Right-click on a selected property 

The following example, described in Figure 37, consists in the creation of the water 

material with the isotopes repartition explicated. To do so, the custom material has 

been filled with two “composites of isotopes”. The template obtained is then 

expanded by duplicating the template isotope. After that, all the characteristics are 

filled up with correct value and the different element are renamed to make the 

created hierarchy understandable. 
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Figure 37: Example of complex material in EDGE (water with the natural 

isotopes repartition) 

6.4. Material editor 

This panel allows the user to edit the values of the material tree displayed on the 

Material tree panel. 

When the name of the material is selected in the Material tree panel, the Material 

editor panel is the one shown on Figure 38. The user can find on this panel the Id of 

the material, its name, its description, its sub-properties and its characteristics. 

The user can change the values of all these fields and validate them by clicking on 

the “Ok” button at the bottom of this panel. 

 

Figure 38: Material editor when the material name is selected 

When a sub-property of a material is selected in the material tree, the Material editor 

panel changes accordingly, as shown on Figure 39. This new panel displays the Id of 

the material, the name of the sub-property, its description, its parent property, 

its sub-properties and its characteristics. As for the previous panel, all fields are 

editable. 
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Figure 39: Material editor when a sub-property is selected 

When a characteristic is selected in the material tree, the corresponding material 

editor panel is as shown on Figure 40. It displays the Id of the characteristic, 

its name, its description and its value. The user can also change the unit of the 

characteristic by clicking on “Edit unit”. 

 

Figure 40: Material editor when a characteristic is selected 
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7. Materials affectation 

The aim of this perspective is to apply the materials defined in the material definition 

view to the geometry defined in the geometry edition view. Thus, this view only 

makes sense when at least one shape has been defined in the geometry 

perspective. 

The materials affectation perspective has the same 3D view as the geometry one 

(like shown on Figure 41): 

1- Materials list 

2- Material selection 

 

Figure 41: EDGE material edition view 

 

7.1. Materials list 

This panel contains a table with two columns. The first column (on the left) lists the 

geometry shapes created in the Geometry edition perspective. The second column 

(on the right) lists the materials attributed to each corresponding geometry shape. 

By default, the GEANT-4 material G4_Galactic (i.e space environment) is attributed 

to the geometry shape representing the world. All other geometry shapes created 

are, by default, composed of Default_Material.  

 

 1 
 

 2 
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7.2. Material selection 

The Material selection panel allows the user to select the material to attribute to a 

geometry shape, defined in the Geometry edition perspective. 

When a geometry shape is selected in the Material list panel, the Material selection 

panel displays several choices for the user: 

 Pre-defined materials: some pre-defined materials exist (see section 6) and 

can be directly used to define the material for the selected shape. When this 

option is selected, a drop down list appears, displaying all default materials 

already available in EDGE (Default_Material and all GEANT-4 materials 

presented in section 6.  

 Custom materials: When this option is selected, a drop down list appears, 

displaying all the materials created by the user in the Material definition 

perspective. 

When the chosen materials are selected in the drop down list, the user must click on 

the “Ok” button of the Material selection panel in order to validate the choice and 

update the table in the Material list panel. 
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8. Annex A: Example of materials description 

Here after is presented an example of material definition in GDML format (partial 

description).  

<materials> 

 

     <!--   Examples of basic or fundamental materials --> 

 

 <element name="videRef" formula="VACUUM" Z="1"> 

  <atom value="1"/> 

 </element> 

 

 <element name="aluminum" formula="Al" Z="13"> 

  <atom value="26.9815"/> 

 </element> 

 

 <element name="carbon" formula="C" Z="6"> 

  <atom value="12.0107"/> 

 </element> 

 

 <element name="Hydrogen" formula="H2" Z="1"> 

  <atom value="1.01"/> 

 </element> 

 

 <element name="Nitrogen" formula="N2" Z="7"> 

  <atom value="14.01"/> 

 </element> 

 

 <element name="Oxygen" formula="O2" Z="8"> 

  <atom value="16.0"/> 

 </element> 

 

     <!--   Examples of complex or composite materials --> 

 

 <material name="Mat_ALUMINUM" formula="ALUMINUM"> 

  <D value ="2.7000" unit="g/cm3"/> 

  <fraction n="1.0000" ref="aluminum"/> 

 </material> 
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 <material name="Mat_Kapton" formula="Kapton"> 

  <D value ="1.42" unit="g/cm3"/> 

  <fraction n="0.0273" ref="Hydrogen"/> 

  <fraction n="0.7213" ref="carbon"/> 

  <fraction n="0.0765" ref="Nitrogen"/> 

  <fraction n="0.1749" ref="Oxygen"/> 

 </material> 

 

</materials> 
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